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Supplementary Information for “Expansion Microscopy with Conventional 

Antibodies and Fluorescent Proteins” 

Figure Result 

Supplementary Figure 1 Post-stain treatment with MA-NHS or GA retains fluorescence for 
cells immunostained with conventional secondary antibodies. 

Supplementary Figure 2 Measurement of ~80 nm microtubule profile for MA-NHS and GA 
treated cells immunostained for tubulin and estimate of ~65 nm 
resolution. 

Supplementary Figure 3 Quantification of expansion fidelity for conventionally 
immunostained cell treated post-stain with MA-NHS and imaged 
by confocal microscopy. 

Supplementary Figure 4 Quantification of expansion fidelity for cell immunostained with 
DNA-labeled secondary antibodies and imaged by confocal 
microscopy. 

Supplementary Figure 5 Quantification of expansion fidelity for conventionally 
immunostained cell treated post-stain with GA; imaged pre-
expansion by super-resolution microscopy and post-expansion by 
epifluorescence microscopy. 

Supplementary Figure 6 Comparison of correlated pre- and post-expansion images of 
spindle-chromosome attachments. 

Supplementary Figure 7 Explanation of image processing procedures used in Fig. 2 e-f. 

Supplementary Figure 8 Quantification of expansion fidelity in three dimensions for 
conventionally immunostained cell treated post-stain with GA. 

Supplementary Figure 9 Gallery of expanded cells immunostained for various structures 
and treated with GA prior to gelation, digestion, and expansion.   

Supplementary Figure 10 Use of MA-NHS or GA treatment with conventional secondary 
antibodies leads to equal or brighter signal compared to DNA-
antibody. 

Supplementary Figure 11 Fluorescence retention measurements of GA, GFP-GA, MA, and 
DNA methods presented in this work. 

Supplementary Figure 12 Comparison of fluorescence images of expanded cells 
immunostained with home-made or commercially available 
conventional fluorescently-labeled secondary antibodies. 

Supplementary Figure 13 GA treatment of cultured cells permits short digestion times 
without expansion artifacts. 

Supplementary Figure 14 MA-NHS treatment of cultured cells requires long-digestion times 
to avoid expansion artifacts. 
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Supplementary Figure 15 Short digestion times favor retention of intrinsic GFP signal in 
cultured cells. 

Supplementary Figure 16 Treatment with GA favors retention of intrinsic GFP signal in 
cultured cells. 

Supplementary Figure 17 Post-stain treatment with MA-NHS or GA retains fluorescence for 
mouse brain tissue immunostained with conventional secondary 
antibodies. 

Supplementary Figure 18 Gallery of zoom-in views of synapses from Fig. 3.  

Supplementary Figure 19 Quantification of expansion fidelity for brain tissue treated post-
stain with MA-NHS and imaged by confocal microscopy. 

Supplementary Figure 20 MA-NHS treatment retains fluorescent protein signal in mouse 
brain slices while no treatment has poor fluorescence retention. 

Supplementary Figure 21 Gallery of expanded cells immunostained for nuclear DNA or 
tubulin using a range of fluorophores attached to antibodies. 

Supplementary Video 1 3D rendering of expanded brain tissue from Fig. 3. 

Supplementary Table 1 Detailed summary of sample preparation and imaging conditions. 

Supplementary Protocol 1 Detailed protocol for magnification calculation and distortion 
analysis. 
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Supplementary Figure 1.  Epifluorescence images of expanded BS-C-1 cells that were 

immunostained against tubulin using conventional fluorophore-labeled antibodies and then 

treated as indicated prior to gelation, digestion, and expansion. (a) Omission of post-stain 

treatment leads to heavy distortion due to lack of retention along the original structure. Post-

stain treatment of immunostained cells with (b) MA-NHS (methacrylic acid N-hydroxyl 

succinimidyl ester) or (c) GA (glutaraldehyde) both conferred excellent retention of 

fluorescence and structure. Scale bars are 2.4 μm and are all in pre-expansion dimensions.  
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Supplementary Figure 2. Confocal fluorescence measurement of microtubule cross-sectional 

profile for 4.15× expanded specimens and estimate of spatial resolution. (a) Confocal 

fluorescence image of an expanded BS-C-1 cell conventionally immunostained for tyrosinated 

tubulin and treated with GA prior to gelation. (b) Representative cross-sectional profiles of 

microtubules (red lines) and Gaussian fits (dashed black lines). (c) Analysis of microtubule 

profiles (red lines in a) yielded an average Gaussian-fitted full width at half maximum (FWHM) 

of 79 ± 9 nm (mean ± SD, 362 microtubule profiles). (d-f) Cross-sectional profile analysis for an 

expanded, MA-NHS treated, conventionally immunostained BS-C-1 cell showing an average 

FWHM of 80 ± 7 nm (mean ± SD, 353 microtubule profiles). All distances and scale bars 

correspond to pre-expansion dimensions. Scale bars are 5 µm. 

Resolution estimate: The observed ~80 nm FWHM profile of microtubules is consistent with the 

convolution of the double-peaked spatial profile of indirectly immunostained microtubules 

(measured by localization microscopy at ~20 nm resolution, Supplementary Fig. 5) with an 

effective ~65 nm Gaussian point spread function (PSF) for expansion microscopy. The value of 

65 nm is also approximately equal to the physical PSF of our microscope (~265 nm FWHM, 

when configured with the 63× 1.2NA water-immersion lens used here) divided by the measured 

expansion factor of 4.15.  
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Supplementary Figure 3. Comparison of pre-expansion and post-expansion images recorded by 

confocal fluorescence microscopy for a region of a BS-C-1 cell immunostained for tyrosinated 

tubulin with a conventional Atto 488 secondary antibody and treated with MA-NHS before 

gelation (data from Fig. 2). (a) Overlay of pre-expansion image (magenta) and post-expansion 

image (green) after alignment of the post-expansion image using similarity registration (i.e., 

translation, rotation, and magnification—see methods for further details). (b) Overlay of post-

expansion image before (magenta) and after (green) a non-rigid transformation procedure that 

uses B-spline registration to “warp” the post-expansion image to optimally fit the pre-

expansion image. Arrows indicate the direction and relative magnitude (scaled 8×) of the 

transformation required to optimally align the post-expansion to the pre-expansion image. (c-f) 

Zoom-in images of boxed regions in b showing that distortions are generally very small. (g) 

Schematic of procedure used to measure distances m and m’ between features a and b in the 

post-B-spline-registration (green) and corresponding features a’ and b’ in pre-B-spline-

registration (magenta). (h) Quantification of root mean square (RMS) error of m-m’ as a 

Nature Methods: doi:10.1038/nmeth.3833
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function of distance m for matching image features (black line) with plus or minus standard 

deviation. The plot in h was calculated from a 20 µm × 20 µm data set; the image in a shows a 

12 µm × 12 µm zoom-in of the data set. All distances and scale bars correspond to pre-

expansion dimensions. Scale bars (a, b) 2 µm, (c-f) 200 nm.  
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Supplementary Figure 4. Comparison of pre-expansion and post-expansion images recorded by 

confocal fluorescence microscopy for a region of a BS-C-1 cell immunostained for tubulin with 

DNA-labeled secondary antibodies and hybridized with a modified complementary strand (5' 

acrydite and 3' Atto 488) prior to gelation. (a) Overlay of pre-expansion image (magenta) and 

post-expansion image (green) after alignment of the post-expansion image using similarity 

registration. (b) Overlay of post-expansion image before (magenta) and after (green) using a 

non-rigid B-spline registration. Arrows indicate the direction and relative magnitude (scaled 8x) 

of the transformation required to optimally align the images. (c,d) Zoom-in images of boxed 

regions in b showing that distortions are generally very small. (e) RMS error vs length distortion 

analysis for data in a (see Supplementary Fig. 3). The plot in e was calculated from a 20 µm × 20 

µm data set; the image in a shows a 12 µm × 12 µm zoom-in of the data set. All distances and 

scale bars correspond to pre-expansion dimensions. Scale bars (a, b) 2 µm, (c,d) 200 nm.   
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Supplementary Figure 5. Comparison of pre-expansion image measured by localization 

microscopy and post-expansion image measured by epifluorescence microscopy for a BS-C-1 

cell immunostained with conventional antibodies and treated with GA prior to gelation. (a) 

Overlay of pre-expansion image (green) and post-expansion image (magenta) after alignment of 

the post-expansion image using similarity registration. (b) Zoom-in of boxed region in a showing 

close agreement between localization microscopy image and expansion microscopy image. (c, 

d) Line profiles of the boxed regions in b. (e) Overlay of post-expansion image before (magenta) 

and after (green) B-spline registration as described in Supplementary Fig. 3. (f-g) Zoom-in 

images from boxed regions in e showing that distortions are generally very small. (h) RMS error 

vs length distortion analysis for data in a (see Supplementary Fig. 3). The plot in h was 

calculated from a 20 µm × 20 µm data set; the image in a shows an 8 µm × 8 µm zoom-in of the 

data set. All distances and scale bars correspond to pre-expansion dimensions. Scale bars, (a, e) 

2 µm, (b) 500 nm, (f, g) 250 nm.   
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Supplementary Figure 6. Comparison of attachments of kinetochore fibers (K-fibers) and 

chromosomes for mitotic cell from Fig. 2 e-j. (a) Maximum intensity projection of a post-

expansion image of a dividing PtK1 cell that was immunostained against tyrosinated tubulin 

(green) and HEC1 (red) using conventional Atto 488 and dually labeled Alexa Fluor 546 and 

biotin secondary antibodies, respectively, and stained for DNA using TO-PRO-3 (blue). (b-i) 

Comparison of pre-expansion images of kinetochore attachments with corresponding post-

expansion images, both imaged by confocal microscopy in z-sections from 400-800 nm 

thickness. (j-m) A subset of attachments showed double-peaked signals that were not 

resolvable in the pre-expansion images. Cross-sectional profiles of HEC1 signal from b, c, g, and 

h, for pre-expansion images (solid black), post-expansion images (red), and a double-Gaussian 

fit to the post-expansion signals (dashed black lines). Double peaks are separated by 149 nm, 

201 nm, 214 nm, and 204 nm, respectively. All distances and scale bars correspond to pre-

expansion dimensions. Scale bars, (a) 5 µm, (b-i) 500 nm. 

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 7. Image processing on post-expansion mitotic spindle data. 

Unprocessed confocal maximum intensity projection (a) of mitotic cell from Fig. 2 and binarized 

kinetochore mask (b) resulting from image filtering (see methods for additional details). Cross-

sectional maximum intensity projection of boxed area in a showing non-specific adsorption of 

the HEC1 antibody (red) to the cell periphery (c) and processed cross-section (d). Unprocessed 

(e-g) versus processed (h-j) single z-section (~225 nm thickness) showing that kinetochore 

attachments are retained after processing. All distances and scale bars correspond to pre-

expansion dimensions. Scale bars, (a, b) 5 µm, (c-j) 2 µm. 

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 8. Comparison of pre-expansion and post-expansion images recorded by 

confocal fluorescence microscopy for immunostained mitotic PtK1 cell (data from Fig. 2, only 

tubulin channel). (a) XY maximum intensity projection overlay of pre-expansion (magenta) and 

post-expansion (green) images after alignment using three-dimensional similarity registration. 

(b) XZ maximum intensity projection along yellow line in a. (c) RMS error vs length distortion 

analysis in three dimensions (see Supplementary Fig. 3). Scale bars 2 µm. All distances and 

scale bars correspond to pre-expansion dimensions. 

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 9. Gallery of expanded cellular structures. Epifluorescence images of 

expanded BS-C-1 cells indirectly immunostained with Atto 488 against (a) tyrosinated tubulin, 

(b) vimentin, (c) TOM20 (outer mitochondrial membrane), (d) PMP70 (peroxisomal membrane 

protein), (e) mito-GFP (inner mitochondrial membrane marker) and (f) Sec61β-GFP 

(endoplasmic reticulum marker) and treated with GA. Scale bars are 4.8 μm and are all in pre-

expansion dimensions.  

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 10. Epifluorescence images of expanded BS-C-1 cells stained for 

tyrosinated tubulin using different procedures. In (a), fixed cells were immunostained using 

conventional fluorescently-labeled antibodies and then treated with GA. In (b), fixed cells were 

immunostained using conventional fluorescently-labeled antibodies and then treated MA-NHS 

prior to gelation. In (c), fixed cells were immunostained using DNA-labeled antibodies which we 

prepared according to the protocol published by Boyden and coworkers.1 Image contrasts have 

been matched to show the relative brightness of the stain achieved in each case; the specimens 

treated with MA-NHS or GA were both approximately 3-4 times brighter than that of the 

specimen stained using the DNA-labeled antibody. We note that the number of fluorophores 

per antibody with the DNA-labeled antibodies was not reported in the original expansion 

publication and it is possible that an optimized DNA-labeled antibody could be brighter than the 

one we prepared here.1 However, we believe the DNA-labeled antibodies would be unlikely to 

achieve brighter stains than conventional (directly) fluorescently-labeled antibodies due to the 

more than ten-fold difference in molecular weight between an individual fluorophore and a 20-

mer single-stranded oligonucleotide. Scale bars are 2.4 μm and are all in pre-expansion 

dimensions. 

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 11. Determination of fluorescence retention for each method performed 

in this work using epifluorescence imaging. In each case, the total fluorescence of individual 

mitochondria was measured before and after expansion using a 20× 0.45 NA air objective. 

Fluorescence retention of GFP was measured using the inner mitochondrial membrane tag 

mito-GFP while all other methods used an outer mitochondria immunostain for TOM20 using 

Atto 488. (a) Pre-expansion image of a representative area used in the determination of GFP 

fluorescence retention. (b) Corresponding area in a after expansion. Scale bars are 10 µm in 

pre-expansion dimensions. (c) Bar graph of fluorescence retention for each method used in this 

work. Error bars represent the standard deviation in measured fluorescence retention (n=20).   

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 12. Epifluorescence images of expanded BS-C-1 cells prepared using the 

GA treatment method. Cells were indirectly immunostained for tyrosinated tubulin using either 

a homemade Atto 488 donkey anti-rat secondary antibody (a) or a commercially available Alexa 

Fluor 488 donkey anti-rat secondary antibody (b). Image contrasts were adjusted to be 

proportional to exposure time in order to show that the two stains are comparable in 

brightness. Scale bars are 2.4 μm and are all in pre-expansion dimensions.  

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 13. (a-c) Epifluorescence images of expanded BS-C-1 cells stained for 

tyrosinated tubulin, treated with GA, and digested for the period indicated. Digestion times 

shorter than 30 minutes show prominent distortions while these are largely absent for 

digestion times of 30 minutes or longer. Scale bars are 2.4 μm and are all in pre-expansion 

dimensions.  

Nature Methods: doi:10.1038/nmeth.3833



 17 
 

 

Supplementary Figure 14. (a-c) Epifluorescence images of expanded BS-C-1 cells stained for 

tyrosinated tubulin, treated with MA-NHS, and digested for the period indicated. Digestion 

times of many hours were required to avoid prominent distortions. Scale bars are 2.4 μm and 

are all in pre-expansion dimensions.  

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 15. Epifluorescence images of expanded BS-C-1 cells expressing Sec61β-

GFP and treated with GA during fixation; intrinsic GFP signal is only retained for short digestion 

times in cultured cells. In (a), the sample was digested for 30 min. In (b), the sample was 

digested for 18 h. The images in a and b were acquired under identical illumination conditions, 

exposure durations, and are displayed with the same contrast. Panel (c) is the same image as in 

b but with 7× contrast to show weak residual fluorescence. Scale bars are 2.4 μm and are all in 

pre-expansion dimensions.

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 16. Epifluorescence images of expanded BS-C-1 cells expressing mito-

GFP and digested for 30 minutes; intrinsic GFP signal is only retained for GA-treated cells. a) 

Treatment with a mixture of PFA/GA (paraformaldehyde and glutaraldehyde) during fixation 

retains intrinsic fluorescence from mito-GFP, whereas b) treatment with only PFA does not. 

Both specimens were subjected to a digestion time of 30 min. Panels a and b are displayed at 

the same contrast although panel b was recorded with ten times the exposure duration. c) 

Adjustment of the contrast of the image in b allows observation of dim residual signal. Scale 

bars are 2.4 μm and are all in pre-expansion dimensions.  

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 17. Epifluorescence images of expanded 100 μm thick THY1-YFP-H 

mouse brain slices immunostained for YFP and subjected to various post-stain treatments. (a) 

No treatment leads to low signal intensity and patchy preservation of signal along structure. (b) 

Treatment with MA-NHS after immunostaining led to higher signal levels with good retention 

along the original structures. (c) Treatment with GA after immunostaining resulted in high 

background signal. The three images were acquired using identical illumination and exposure; 

the images in b and c are displayed at the same contrast, while a is displayed with 3× contrast 

to show details within the comparably dim image. Due to the comparably long (~12 hour) 

digestion used here, there should be a negligibly small amount of intrinsic YFP signal remaining, 

in comparison to the data in Supplementary Fig. 20 which show weak residual YFP signal after a 

60 min digestion. Scale bars are 12 μm and are all in pre-expansion dimensions. 

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 18. Gallery of expanded synapses in mouse brain tissue. Maximum 

intensity projections (a, c, e, g, i) of expanded THY1-YFP-H mouse brain tissue indirectly 

immunostained for YFP (blue, Atto 488), Bassoon (green, Atto 565), and Homer (red, Atto 647N) 

along with corresponding cross-sectional profiles of the indicated individual synapses (b, d, f, h, 

j, k). In each case, the pre- and postsynaptic densities are clearly resolvable and align well with 

dendritic spines. In i, two separate synapses are shown connecting to a single dendritic spine 

(cross-sectional profiles indicated with arrows). All distances and scale bars correspond to pre-

expansion dimensions. Scale bars are 500 nm.  
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Supplementary Figure 19. Comparison of pre-expansion and post-expansion images recorded 

by confocal fluorescence microscopy for a 100 μm thick THY1-YFP-H mouse brain slices 

immunostained for YFP. (a, b) Large area overlay of pre-expansion image (magenta) and post-

expansion image (green) after alignment of the post-expansion image using similarity 

registration. (c, d) Overlay pre-expansion image (magenta) and post-expansion image (green) 

using similarity transformation in a local region. (e, f) Overlay of post-expansion images from 

before (magenta) and after (green) B-spline registration as described in Supplementary Fig. 3.  

(g) RMS error vs length distortion analysis for data in a and b (see Supplementary Fig. 3). All 

distances and scale bars correspond to pre-expansion dimensions. Scale bars (a, b) 10 µm, (c, d, 

e, f) 5 µm. 

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 20. Epifluorescence images of 100 μm thick THY1-YFP-H mouse brain 

slices treated with either MA-NHS or nothing prior to gelation, a brief (60 min) digestion, and 

expansion. While both specimens expanded well, the MA-NHS treated brain slice in (a) showed 

much higher intrinsic YFP signal than the non-treated brain slice shown in (b). The images in a 

and b were acquired with identical illumination and exposure and are displayed with the same 

contrast settings. The image in (c) is a duplicate of that in b but is displayed with 3x contrast. 

Note that use of a long digestion time (>12 hours) led to essentially zero detectable signal (data 

not shown). Scale bars are 30 μm (pre-expansion dimensions).  

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Figure 21. Confocal fluorescence maximum intensity projections of expanded 

BS-C-1 cells stained for DNA or immunostained against tyrosinated tubulin using various 

secondary antibodies and treated with GA prior to gelation. In panels b, c, e, and f, 

conventional secondary antibodies were used that were directly labeled with the indicated 

fluorophore. Panels a and d were stained for nuclear DNA using the corresponding dye without 

subsequent GA treatment. In g, a biotinylated secondary antibody was used prior to treatment 

with GA; after expansion the sample was incubated with Alexa Fluor 647 labeled streptavidin. 

Post-expansion labeling offers a way to introduce fluorophores to the sample that would 

otherwise not survive the polymerization step such as Alexa Fluor 647 and other cyanines.1 

Scale bars are 3.75 μm and are all in pre-expansion dimensions.  

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Video 1. 3D animation of expanded brain slice shown in Fig. 3. The animation 

begins as 29 × 13 μm and then zooms to show a view of 4.6 × 2.7 μm (all distances are in pre-

expansion dimensions).  

Nature Methods: doi:10.1038/nmeth.3833
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Supplementary Table 1. Summary of sample preparation and imaging conditions. 
Figure Specimen Fixation 1° Ab 

all 1-2 µg/mL 
2° Ab, etc., & dyes/protein 
1-2.5 µg/mL, except as 
indicated 

Polymer-linking Digestion time & other notes Imaging 
Image thicknesses in pre-
expansion dimensions 

2 a-c BS-C-1 cell, wildtype Extracted, then 
PFA/GA 

Rat × Tub & 
Rb × dTub 

D × Rat Atto 488 (~5.6 d/p) &  
D × Rb Alexa 546 (~12 d/p) 

25 mM MA-NHS, 60 min Overnight Confocal, 63× 1.2NA water lens 
Image thicknesses: a) 900/200 
nm; b) 900 nm; c) 225 nm 

2 e-j, 
Supp. 
Fig. 6, 
7, 8 

PtK1 cell, wildtype Extracted, then 
PFA/GA 

Rat × Tub & 
Ms × HEC1  

D × Rat Atto 488 (~7.1 d/p) & 
D × Ms Alexa 546 (~5 d/p)  
     +biotin 

0.25% GA 10 min Overnight digestion; post-
expansion incubation with 
streptavidin Alexa 546 (2 
µg/mL, ~7 d/p) and TO-PRO-3 (1 
µM) 

Confocal, 63× 1.2NA water lens. 
Image thicknesses: 2e,f) 5.6 μm; 
2g) 900 nm; 2h) 420 nm; S6) ~800 
nm; S7a) 5.6 μm; S7e-j) 225 nm; 
S8a) 5.6  μm; S8b) 130 nm. 

2 k-l BS-C-1 cell expressing 
Sec61β-GFP & mito-
DsRed 

PFA/GA, 37 °C Rb × TOM20 D × Rb Atto 647 N (~2.7 d/p) 
 

0.25% GA 10 min  30 min Confocal, 63× 1.2NA water lens. 
Detected intrinsic GFP & YFP 
signal as well as signal from Atto 
647N stain. Image thicknesses: k) 
1 μm; l) 225 nm 

Supp. 
Fig. 1 

BS-C-1 cells, wildtype Extracted, then 
PFA/GA 

Rat × Tub D × Rb Atto 488 (9-12 d/p) 
 

a) no treatment 
b)25 mM MA-NHS 60 min  
c) 0.25% GA 10 min 

Overnight Epifluorescence, 60× 1.2NA water 
lens 

Supp. 
Fig. 2 

BS-C-1 cells, wildtype Extracted, then 
PFA/GA 

Rat × Tub D × Rat Atto 488 (~5.6 d/p) a) 0.25% GA 10 min 
c) 25 mM MA-NHS 60 min 

Overnight Confocal, 63× 1.2NA water lens. 
Image thickness ~225 nm 

Supp. 
Fig. 3 

BS-C-1 cell, wildtype Extracted, then 
PFA/GA 

Rat × Tub D × Rat Atto 488 (~5.6 d/p) 25 mM MA-NHS, 60 min Overnight Confocal, 63× 1.2 NA water lens. 
Image thickness ~225 nm 

Supp. 
Fig. 4 

BS-C-1 cell, wildtype Extracted, then 
PFA/GA 

Rat × Tub D × Rat DNA  Overnight  

Supp. 
Fig. 5 

BS-C-1 cell, wildtype Extracted, then 
PFA/GA 

Rat × Tub Ms × Rat Alexa 647 (~5.3 d/p) 
3° Ab D × Ms Atto 488 (~6 d/p) 

0.25% GA 10 min Overnight Pre-expansion localization 
microscopy with 100× 1.45NA 
TIRF lens; post-expansion imaging 
by epifluorescence with 60× 
1.2NA water lens 

Supp. 
Fig. 9 

BS-C-1 cells: a-d) 
wildtype;  
expressing  
e) mito-GFP or 
f) Sec61β-GFP 

a-b) extracted, 
fixed with PFA/GA 
c-f) not extracted, 
fixed with PFA/GA  
 

a) Rat × Tub 
b) Ms × Vim 
c) Rb × TOM20 
d) Rb × PMP70 
e,f) Rb × GFP 

a) D × Rat Atto 488 (4-6 d/p) 
b) D × Ms Atto 488 (4-6 d/p) 
c) D × Rb Atto 488 (4-6 d/p) 
d) D × Rb Atto 488 (4-6 d/p) 
e,f) D × Rb Atto 488 (4-6 d/p) 

0.25% GA 10 min Overnight 
 
 

Epifluorescence, 60× 1.2NA water 
lens 

Supp. 
Fig. 10 

BS-C-1 cells, wildtype Extracted, then 
PFA/GA 

Rat × Tub a-b) D × Rat Atto 488 (~8 d/p) 
c) D x Rat DNA (2.25 µg/mL) + 
1 μM acrydite-DNA-Atto 488 

a) 0.25% GA 10 min 
b)25 mM MA-NHS 60 min  
c) no post-stain linking  

Overnight Epifluorescence, 60× 1.2NA water 
lens 

Supp. 
Fig. 11 

BS-C-1 cells, wildtype 
and expressing mito-
GFP 

Not extracted, 
fixed with PFA/GA 

Rb × TOM20 
for antibody 
measurements 

D × Rb Atto 488 (~8 d/p)  
D × Rb DNA (2.25 µg/mL) + 1 
μM acrydite-DNA-Atto 488  

Either 0.25% GA 10 min, 
25 mM MA-NHS 60 min, 
or no post-stain linking 
(DNA) 

Both GA: 30 min 
Antibody MA and DNA: 
overnight 

Epifluorescence, 20× 0.45 NA air 
lens. Detected antibody or 
intrinsic GFP signal as indicated. 

Supp. 
Fig. 12 

BS-C-1 cells, wildtype Extracted, then 
PFA/GA 

Rat × Tub a) D × Rat Atto 488 (~8 d/p) 
b) D × Rat Alexa 488 (~8 d/p, 
commercial) 

0.25% GA 10 min Overnight Epifluorescence, 60× 1.2NA water 
lens 

Supp. 
Fig. 13 

BS-C-1 cells, wildtype Extracted, then 
PFA/GA 

Rat × Tub D × Rat Atto 488 (~8 d/p) 0.25% GA 10 min a) No digestion, b) 30 min, c) 18 
h 

Epifluorescence, 60× 1.2NA water 
lens 

Supp. 
Fig. 14 

BS-C-1 cells, wildtype Extracted, then 
PFA/GA 

Rat × Tub D × Rat Atto 488 (~8 d/p) 25 mM MA-NHS 60 min a) No digestion, b) 2h, c) 18 h Epifluorescence, 60× 1.2NA water 
lens 

Supp. 
Fig. 15 

BS-C-1 cells 
expressing Sec61β-
GFP 

PFA/GA, 37 °C -- -- Initial fixation included 
0.1% GA for 10 min 

a) 30 min, b,c) 18 h Epifluorescence, 60× 1.2NA water 
lens. Detected intrinsic GFP signal. 

Supp. 
Fig. 16 

BS-C-1 cells 
expressing mito-GFP 

a) PFA/GA 
b,c) PFA 

-- -- Initial fixation included 
0.1% GA for 10 min 

30 min Epifluorescence, 60× 1.2NA water 
lens. Detected intrinsic GFP signal. 

3 a-f THY1-YFP-H mouse 
brain, 100 μm slice 

Cardiac perfusion 
with PFA, then 1 h 
PFA after slicing 

Ch × GFP 
Rb × Homer 
Ms × Bassoon 

a) D × Ch Atto 488 (~6 d/p) 
b) D × Rb Atto 647N (~2.7 d/p) 
c) D × Ms Atto 565 (~5.2 d/p) 

1 mM MA-NHS 60 min 
 

Digestion: overnight Confocal, 25× 1.0 NA water SCALE 
lens. Image thicknesses: a) ~1.2 
μm (single z-plane); b) ~3.8 μm; c-
d) ~1.2 μm (single z-plane); e, f) 
1.4 μm. 

3 i-j THY1-YFP-H mouse 
brain, 100 μm slice 

Cardiac perfusion 
with PFA, then 1 h 
PFA after slicing 

-- -- 1 mM MA-NHS 60 min 
 

60 min Epifluorescence, 20× 0.45NA air 
lens 

Supp. 
Fig. 17 

THY1-YFP-H mouse Cardiac perfusion 
with PFA, then 1 h 
PFA after slicing 

Rb × GFP D × Rb Atto 488 (~9 d/p) a) 1 mM MA-NHS 60 min 
b) 0.1% GA 10 min 

Overnight Epifluorescence, 10× 0.25 NA air 
lens 

Supp. 
Fig. 18, 
Supp. 
Vid. 1 

THY1-YFP-H mouse Cardiac perfusion 
with PFA, then 1 h 
PFA after slicing 

Ch × GFP 
Rb × Homer 
Ms × Bassoon 

a) D × Ch Atto 488 (~6 d/p) 
b) D × Rb Atto 647N (~2.7 d/p) 
c) D × Ms Atto 565 (~5.2 d/p) 

1 mM MA-NHS 60 min Digestion: overnight  
 

Confocal, 25 × 1.0 NA water lens. 
Image thicknesses: a) 0.8 μm; c) 
1.6 μm; e) 1.8 μm; g) 2 μm; i) 2.2 
μm. 

Supp. 
Fig. 19 

THY1-YFP-H mouse Cardiac perfusion 
with PFA, then 1 h 
PFA after slicing 

Ch × GFP 
Rb × Homer 
Ms × Bassoon 

a) D × Ch Atto 488 (~6 d/p) 
b) D × Rb Atto 647N (~2.7 d/p) 
c) D × Ms Atto 565 (~5.2 d/p) 

1 mM MA-NHS 60 min 
 

Digestion: overnight Confocal, 25 × 1.0 NA water lens.  
Image thicknesses: 13.2 µm 

Supp. 
Fig. 20 

THY1-YFP-H mouse Cardiac perfusion 
with PFA, then 1 h 
PFA after slicing 

-- -- a) 1 mM MA-NHS 60 min 
b) No treatment 

Digestion: overnight Epifluorescence, 20× 0.45 NA air 
lens. Detected intrinsic YFP signal. 

Supp. 
Fig. 21 

BS-C-1 cells, wildtype Extracted, then 
PFA/GA 

Rat × Tub for 
tubulin stains 
only 

a) Hoechst (2 drops/mL) 
b) D × Rat Alexa 405 (~3 d/p) 
c) D ×Rat Atto 488 (~10 d/p) 
d) SYBR Gold (10×) 
e) D × Rat Alexa 546 (~10 d/p) 
f) D × Rat Atto 647N (~5.5 d/p) 
g) D × Rat Biotin 

a-e) 0.25% GA 10 min 
 

a-f) Overnight digestion 
g) 1 h digestion. 
Post-expansion with 
streptavidin Alexa 647 (3 
dyes/SA, 2 μg/mL) 

Confocal, 63× 1.2 NA water lens. 
Image thicknesses: tubulin, 225 
nm; nuclei, 7 µm. 
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Supplementary Protocol 1. Detailed protocol for magnification calculation and distortion 

analysis. 

In this manuscript we used the open-source software Elastix for analysis of correlated 

pre- and post-expansion images in order to calculate the physical magnification (referred to as 

the expansion factor in the main text) and to perform analysis of expansion-related distortions.2 

The output from Elastix was further processed using custom-written Mathematica scripts. In 

this supplementary protocol we provide detailed instructions on how to perform these analyses 

for a computer based on a Microsoft Windows operating system. This protocol also makes use 

of the widely used open-source ImageJ-based software package Fiji [insert ref here]. 

This supplementary protocol is accompanied by the file “SupplementaryAnalysis.zip”. 

The .zip file contains three subfolders: “original_data” contains original confocal data files for 

corresponding pre-expansion and post-expansion images; “similarity_example” contains input 

files for rigid registration analysis using Elastix; “spline_example” contains input files for 

distortion analysis with Elastix that are derived from the output of the similarity analysis. The 

spline_example folder also contains a Mathematica script file (.nb) for processing of the Elastix 

B-spline output file for distortion analysis. 

Elastix Installation 

The open-source software Elastix was used for rigid (similarity) and nonrigid (B-spline) 

registration of correlated pre- and post-expansion images. Elastix may be downloaded from the 

program’s website at http://elastix.isi.uu.nl. Once installed, add the installed Elastix directory to 

the system’s PATH variable. Elastix is controlled through the Command Prompt, and the 

following font and gray background will be used to denote command line inputs: command line 

inputs. To check whether the installation was successful, open a Command Prompt and enter 

elastix -help to see the version and command options (an error is returned if the installation 

was unsuccessful or if Elastix directory has not been added to the PATH variable). For more 

detailed information on installation, information about image registration, and all further 

procedures, consult the Elastix manual found on the homepage. The Elastix parameter 

database also has helpful example parameter files for analysis 

(http://elastix.bigr.nl/wiki/index.php/Parameter_file_database). 

Image Data Formatting Preparation 

Elastix is based on the Image Registration and Segmentation Toolkit (ITK), and therefore 

all input/output image files must be compatible with ITK, such as .mhd or .mha files that store 

image data in uncompressed binary format. It is convenient to use other imaging applications 

such as Fiji (http://fiji.sc/Fiji)3 to create or view these binary image files. To create binary image 

files for our sample pre-expansion data located in the original_data folder, perform the 

following steps: 1) Load the example pre-expansion data file “Pre_ExM.tif” (a 128 × 128 pixel 16 
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bit TIFF) into Fiji; 2) Use bicubic interpolation to resample the image with 4× smaller pixels 

(Image → Scale… → X Scale = 4, Y Scale = 4), resulting in a 512 × 512 image, so that the pre-

expansion data will have approximately the same scale as the post-expansion data; 3) Save the 

image as a binary file by selecting (File → Save As… → Raw Data…), and name it “fixed.raw”; 4) 

Manually create a “.mhd” metadata file (MetaImage medical data) that contains the 

information shown below. The binary image file and metadata files generated according to this 

procedure are included in the similarity_example folder as “fixed.raw” and “fixed.mdh”, 

respectively. 

ObjectType = Image 

NDims = 2 

BinaryData = True 

BinaryDataByteOrderMSB = True 

ElementSpacing = 1 1 

DimSize = 512 512 

ElementType = MET_USHORT 

ElementDataFile = fixed.raw 

 

Follow a similar procedure to create a binary image file and metadata file for the 

example post-expansion image “Post_ExM.tif” (a 512 × 512 pixel 16 bit TIFF), but omitting the 

bicubic interpolation step. These binary image and metadata files are included in the 

similarity_example folder as “moving.raw” and “moving.mdh”, respectively. 

Troubleshooting note regarding file formats: Depending on the software and/or 

computer preferences for byte order (i.e., “endianness”), the .mdh metadata parameter 

BinaryDataByteOrderMSB may need to be changed to either True or False in order to be loaded 

properly by Elastix. In ImageJ and Fiji, “Raw Data…” export should default to big-endian byte 

order and the BinaryDataByteOrderMSB option should be set to True in the .mhd file. Validate 

the byte ordering is correct by loading the “.mhd” file into Fiji; when correctly formatted, the 

original images should appear normally as shown in Appendix Figure 1a and b (i.e., not 

scrambled). The initial overlay should be roughly the same region and scaling as in Appendix 

Figure 1c).  

General Elastix Usage: Similarity Transform 

Elastix compares two input images, denoted the fixed image and the moving image, and 

will attempt to rigidly or nonrigidly transform the moving image so that it matches the fixed 

image file. Example files are provided in the similarity_example and spline_example folders. 

The example files in each folder include a fixed image, a moving image, the corresponding .mhd 

metadata files, and an Elastix parameter files.  
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In this example, we will use the parameter file “Parameters_Similarity.txt” provided in 

the example files. To run Elastix, open a Command Prompt inside the “similarity_example” 

folder by pressing together Shift + Right Click, selecting “Open command window here”, and 

entering: 
elastix -f fixed.mhd -m moving.mhd -p Parameters_Similarity.txt -out . 

The –f and –m indicate the fixed and moving image “.mhd” input files, the –p indicates 

the parameters input file, and –out indicates where the output files will be written. The period 

(.) after -out is shorthand for the current directory of the command prompt, however any valid 

path will work. In general, use file names that do not contain spaces (underscores are 

acceptable), or alternatively enclose names or full file paths with quotation marks. After Elastix 

finishes running, an output binary image file “result.0” and its corresponding “result.0.mhd” file 

should be generated. Check the output image by dragging the “result.0.mhd” file into Fiji. 

Overlay the fixed and result.0 images to display the registration result, as displayed in Appendix 

Figure 1d. Note that signedness of the output (MET_SHORT) is different from the input 

(MET_USHORT) and is specified in corresponding .mhd files; however the output will be 

displayed correctly when opened with FIJI. 

 

Appendix Figure 1. The “fixed” pre-expansion (a) and “moving” post-expansion (b) images to be 

registered by Elastix. The initial unregistered overlay (c) and overlay after Elastix similarity 

registration (d). The pre-expansion images are displayed in magenta and the post-expansion 

images in green. The dotted yellow lines in (d) outline the edges of the post-expansion image 

and have been added to emphasize the transformation. 

Troubleshooting notes regarding Elastix command line usage. If Elastix does not run, 

observe the error output in the command window, or look for the “elastix.txt” output file, 

which should also contain the error. Common errors include incorrect input of file names into 

the command line, file names containing spaces, or an incorrect “ElementDataFile” name 

referencing the binary data in the .mhd file. Additionally, be wary of extra file extensions that 
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may become appended (particularly in Windows), but appear hidden on the .raw and .mhd 

files, which will cause Elastix to respond with an error.  

Expansion Factor Determination with Elastix 

 The similarity transformation (used in the previous example) attempts to match the 

moving image to the fixed image using only rotation, translation and isotropic scaling; and can 

therefore be used to calculate the isotropic expansion factor. In the previous example, the pre-

expansion image was interpolated by a factor of 4; this factor was the estimated expansion 

factor determined macroscopically with a ruler (by measuring the size of the gel in millimeters 

before and after expansion). All ExM samples in this work had expansion factors ranging from 

4.0-4.3, so a flat factor of 4 is a good initial guess for the similarity transform. Even this type of 

rough macroscopic measurement can yield results accurate to within 5-10% of the true 

expansion factor. Note, if the images were acquired with different pixel sizes (such as on a 

confocal microscope with adjustable magnification), it is convenient to first interpolate one of 

the images to match the smaller pixel size of the two; this is unnecessary if images were 

acquired with the same pixel size, such as on a CCD/CMOS array using the same objective lens. 

After successfully performing the similarity transform and ensuring proper registration of the 

two images, as in Appendix Figure 1d, look for the output text file named 

“TransformParameters.0.txt” which contains the following parameters of the similarity 

transform at the top of the document: 

(Transform "SimilarityTransform") 

(NumberOfParameters 4) 

(TransformParameters 1.029177 0.163145 13.092766 17.873457) 

(InitialTransformParametersFileName "NoInitialTransform") 

(HowToCombineTransforms "Compose") 

 

 The key numbers are the TransformParameters, which represent the image scaling 

factor, rotation, translation in X, and translation in Y, respectively. The transformation is applied 

to the moving image (post-expansion image) and since the pre-expansion image was previously 

interpolated by the estimated factor of 4, this factor is multiplied by the scaling factor to get 

the true expansion factor: 4 × 1.03 = 4.12. 

 Troubleshooting Similarity Transform. If the similarity transformation does not return 

acceptable registration, it is useful to first try and select corresponding areas of the input pre-

expansion and post-expansion images to be as close as possible by eye before running Elastix. 

This includes scaling by the estimated expansion factor (as described previously), as well 

matching the image orientations by rotating one of the images (In Fiji, Image → Transform → 

Rotate…). Additionally it is possible to tune the input parameter file 

“Parameters_Similarity.txt”. Some useful parameters to consider are the (NumberofResolutions 

8) or (MaximumNumberOfIterations 1000). Elastix will begin initial registration at a reduced 
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image resolutions and increasing to full resolution, (by default each resolution to run is 

decreased by factor of 2), unless otherwise specified in the parameters file, and the 

MaximumNumberOfIterations will allow for convergence during each resolution. These 

parameters are set initially at higher values for more robust registrion, however often times if 

the initial input images are similar, the number of resolutions and max iterations can be 

decreased to save computation time. Note that the similarity transform is a rigid transform, and 

only performs uniform scaling in X and Y, rotation and translation. If the scaling in X and Y are 

not uniform, which is typically not the case for ExM (unless for example, the gel is being 

stretched or imaging during pre- and post-expansion imaging was not performed on the same 

axis), it may be necessary to use an affine registration by changing the (Transform "Similarity") 

to (Transform "AffineTransform") in the parameters file.  

Nonrigid B-spline Registration with Elastix 

 The similarity transform is a rigid registration and attempts to make a global best match, 

but correct for local deviations from the fixed image, making it necessary to apply a nonrigid 

bspline registration. Essentially, the output of the similarity transform is plugged back into 

Elastix as the moving image, and a second registration using B-spline parameters is used to 

correct for nonrigid deformations that may be present between the pre-expansion and post-

expansion, similarity transformed output image. The data for this example is in the 

“spline_example” folder, and should contain a fixed and moving binary data files and 

corresponding .mhd files, as well as a “Parameters_BSpline.txt” file. Although the files are 

already included, the “moving” and “moving.mhd” are simply copies of “result.0” and 

“result.0.mhd” from the “similarity_example” folder, and renamed accordingly (it is important 

to change the ElementDataFile name in the .mhd as well). The Command Prompt input to run 

this parameter set in the spline_example folder is: 
elastix -f fixed.mhd -m moving.mhd -p Parameters_BSpline.txt -out . 

 

 The resulting image “result.0” should show only minor deformation when overlayed 

with the input “moving” image. Further processing to create the deformation vector field plot 

and measurement RMS error plot using the output B-spline transformation parameters is 

possible using another program included in the Elastix installation called Transformix. 

Vector Fields and RMS error Error using Transformix Output 

 Transformix is a complementary program to Elastix that is used to apply a deformation 

to an image, or a list of XY coordinates. The deformation information is contained within the 

“TransformParameters.0.txt” files. Here, Transformix is used to apply a deformation to a set of 

input points (an example of using Transformix on an image file is provided later). Due to the 

more advanced formatting, parsing and plotting requirements of the input and output data 

with Transformix, an example Mathematica notebook “Vector and RMS plot.nb” is included to 

generate the deformation vector field plots, as well as measure the RMS error (as in 

Supplemental Fig. 3). The script is commented to contain instructions.  
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Briefly described here, to create the vector plot, the deformation field is applied to an 

input array of points sampled at a set interval, in this case every 10 pixels. Transformix is used 

deform these input points, and the deformation vector at each point is then used to make a 

plot of the deformation field. The Command Prompt input to run Transformix  on set of input 

points is:  
transformix -def inputPoints.txt -out . -tp TransformParameters.0.txt 

The input points should be formatted as follows (see “inputPoints.txt” file in the 

spline_example folder):  

Index 

Total # of points 

X1 Y1 

X2 Y2 

…  … 

 

 To generate the measurement RMS error plots , a similar procedure to the vector plot is 

used, however the input points are the coordinates of a binary skeleton of the fixed image. In 

the script, the distance between a pair of points is calculated (m), as is the distance between 

the deformed coordinates (m’, see Supplemental Fig. 3). The absolute value of the difference is 

the error. This is performed for all combinations of input coordinates in the image skeleton, and 

RMS error is calculated and plotted.  

Gaussian Blurring of Post-ExM Images 

For the sake of simplicity in the previous examples, the following steps on Gaussian 

blurring of the initial moving image were excluded from this protocol, but were carried out in 

analysis in the Supplemental Figures. When comparing the pre-expansion and post-expansion 

example images (in these examples, microtubules), there is a disparity in the microtubule width 

between the two, due to the increase in resolution in post-expansion space. To ensure that this 

width disparity does not affect the similarity or Bspline registration process, we first apply a 

Gaussian blur to the post-expansion image in Fiji (Process → Filters → Gaussian Blur… → Radius 

= 4) to make the microtubule widths roughly equivalent, then proceed with this blurred image 

as the moving image in similarity registration and subsequently, the blurred similarity output in 

the Bspline registration. Once the transformation parameters have been determined, the 

deformations can be applied to the original, unblurred image using Transformix. By using the 

following command: 
transformix -in unblurred.mhd -out . -tp TransformParameters.0.txt 

where the unblurred.mhd file corresponds to the original unblurred moving image, and 

“TransformParameters.0.txt” correspond to the similarity transform parameters output in the 
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“similarity_example” folder. The Transformix output will be called “result” and “result.mhd”; 

these images are then plugged back into Transformix using the Bspline output parameters in 

the “spline_example” folder likewise.  

3D Registration in Elastix 

 Rigid and nonrigid registration is easily extended into three dimensions using the earlier 

procedures with minor changes. Beginning from an image stack (assume a 512 × 512 × 128 pixel 

image) in Fiji, save the data as “Raw Data…” as done previously. The corresponding metadata 

.mhd must be modified to contain: 

ObjectType = Image 

NDims = 3 

BinaryData = True 

BinaryDataByteOrderMSB = True 

ElementSpacing = 1 1 1 

DimSize = 512 512 128 

ElementType = MET_SHORT 

ElementDataFile = moving.raw 

 

 The important fields to update are the NDims = 3, to denote three dimensional data, 

and DimSize with the appropriate image dimensions (in this case, the 128 refers to the number 

of z-planes). Again, it is helpful to check that the metadata file is correct by dragging it into Fiji 

and checking if the image opens correctly. Finally, change the Elastix parameter files 

(“Parameters_Similarity.txt” or “Parameters_Spline.txt”) FixedImageDimension and 

MovingImageDimension fields to read: 

(FixedImageDimension 3) 

(MovingImageDimension 3) 

 

 Once these changes to the metadata and parameters files are made, Elastix can be 

called from the command line in the familiar manner. 

Concluding Remarks 

In general, due to the large amount of book-keeping involved for image, metadata and 

Elastix outputs files, we recommend running Elastix using a user preferred scripting language to 

automate the process, such as Mathematica, MATLAB,  Python, etc. Many of these tools are 

already in existence, refer to Additional Tools on the Elastix Wiki 

(http://elastix.isi.uu.nl/wiki.php) or SimpleElastix (http://simpleelastix.github.io). This protocol 

and basic command line usage is meant to serve as a primer for using Elastix with correlative 

expansion microscopy. 
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